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INTRODUCTION TO QGIS 

PRACTICAL EXERCISE 1A 

The purpose of this exercise is to introduce first time/beginner level users to the 
QIS Interface. This session will provide an overview of the QGIS interface by 
focusing on: 
 
1) Setting up the interface for first-time use 

 

2) Introducing some of the important features of the interface and where they 

are located  

 
3) Practical examples of loading data, removing data and simple manipulation 

of data layers 

 
4) Observing details about data through the {Properties} menu (i.e. coordinate 

system, meta-data, styling details etc.) 

 
The following assumptions have been made in relation to delivery of this 

practical workshop session: 

 Workshop participants have had little or no experience with QGIS or other 

GIS applications 

 

 QGIS version 2.8.3 (Wien) has been pre-installed on participants’ Windows 

or Mac computers and will be used to perform the exercises. 

 

 Participants have acquired the necessary data for use in practical exercises 

 
Instructors 

 Mr. Grahame Niles - Remote Sensing/GIS Specialist, CIMH, Barbados 

 

 Ms. Elena Flórez -  Junior scientist, Agencia Estatal de Meteorología, Spain 

 

 Mr. Courtney Forde - Intern, CIMH, Barbados 

 

 Ms. Soumaya Ben Rached - Ingénieur des travaux, Institut National de la                                                    

Météorologie, Tunisia 
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1 PREPARING YOUR QGIS INTERFACE 

Follow the instructions provided in this section to customize the QGIS interface 
so that it is simpler and more easily grasped. Please note that if this is the first 
time using QGIS, your instance of the application may look quite similar to the 
image below when it is launched. However, if other users of your machine have 
previously customized the existing QGIS installation, then it may possibly look 
quite different from this image. The next steps ensure that all tutorial 
participants are working with the same basic interface. 
 

 
  

1. Launch QGIS: 
 

a. For Windows users, QGIS may be launched from the Desktop icon or 
via the Start Menu. 
 

b. Mac users can locate the QGIS application in the Applications 
directory under “Finder”.  
  

2. Locate the [View] menu and scroll to {Toolbars} as shown in the following 
image. 
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Note: This action reveals a drop-list of toolbar options which may be enabled or 

disabled. Enabled toolbars are marked with an „x‟ and disabled toolbars have blank 

check-boxes. 

 

3. Disable all options from the {Toolbars} menu except {Attributes}, {File} 
and {Map Navigation}. 

 

 

Note: The {Attributes}, {File} and {Map Navigation} toolbars are 

illustrated below. These toolbars are commonly used to perform 

most of the basic operations related to handling data in QGIS. 

There are other toolbars in the list which are very convenient 

and effective. However, we have removed them in order to keep 

the appearance of the interface simple. Additional toolbars may 

be added at any time from the menu if you should so desire.   

 

{Attributes} 

 

                                                       

{File} 

 

 

 

{Map Navigation}    
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4. Browse to the [View] menu and scroll to {Panels} as shown. 

 

Note: This reveals another drop-list of options which may also be enabled or disabled.  

 
 

5. Enable the {Layers} and {Browser} options and disable all others. 

 

Note: The {Layers} and {Browser} options are very useful. They 

will be amongst the most heavily utilised part of the interface 

during the exercises. 

 

 

 

 

 

 

Your QGIS interface should now resemble the following image. 
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2 INTRODUCING THE QGIS INTERFACE 

Now that QGIS has been customized for simplicity, a formal introduction may 
proceed. 



 
 

7 

 1
st
MedCOF Training Workshop.  Madrid, 26-30 October 2015 

 

 

Main Menus 

Browser and Layers Panel Map Canvas 

Toolbars 

Status Bar 



 
 

8 

 1
st
MedCOF Training Workshop.  Madrid, 26-30 October 2015 

 

The previous image illustrates 5 important regions of the QGIS interface. These 
are briefly explained below. 
 

i. The Main Menus  

 

They provide access to virtually all functionality within the QGIS platform 
through the [Project], [Edit], [View], [Layer], [Settings], [Plugins], 
[Vector], [Raster], [Database], [Processing] and [Help] menus. A few of 
these menus are briefly described below. 

 
 [Project] menu – This contains sub-menu operations such as {New}, 

{Open}, {Save} and {Save As...} that are typical of most Windows 
application [File] menus. From [Project], you may also export the QGIS 
project you are developing as an image via the {Save as Image...} 
operation. 
 

 [Edit] menu – Use this menu to access a series of advanced operations 
that allow you to modify features of your project data in special ways. 
Some of these useful operations will be explored in successive 
exercises. 
 

 [View] contains standard map visualisation operations which allow one 
to accomplish tasks such as dynamically changing the scale of maps and 
data by zooming (in and out), selecting/highlighting and identifying and 
measuring data features of interest. As previously demonstrated, the 
[View] menu also provides customisation capabilities for the QGIS 
interface, via the {Panels} and {Toolbars} sub-menus. 
 

 GIS data can exist in a variety of formats. The [Layer] menu provides a 
number of useful resources for managing the data layers in an existing 
project. Different types of spatial data can be imported, copied, extracted 
and exported to different formats and even queried from this menu. 
 

 The [Vector], [Raster] and [Processing] menus contain key data 
manipulation, geoprocessing and spatial data analysis functions that are 
cornerstone to GIS. Some of these will be explored during the workshop.    
 

ii. The Toolbars  

 

 
 

This row of tools highlighted on the interface is a set of iconic shortcuts to 
many of the commonly used functions/operations that may be accessed via 
the main menus. For convenience, additional toolbars may be added to this 
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section and other areas of the interface via the {Toolbars} sub-menu within 
the main [View] menu. 

 
iii. Layers/Browser Panel 

 
Users may toggle between the 
Browser and Layers panels (see 
highlighted tabs at the base of the 
panel). The Browser panel 
provides a directory listing for all 
the files on the system which QGIS 
is installed on. From here, you can 
browse through system directories 
to locate spatial data and import 
them into QGIS as data layers. 
The Layers Panel lists all data 
layers that have been imported into 
QGIS. You can directly interact 
with layers in this list by clicking on 
them. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

iv. The Map Canvas (See page 7) 
 

 

The Map Canvas is where data are graphically displayed. Any changes to 
data made through the Main Menus, the Toolbars or the Layers panel are 
made visible here. 
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v. Status Bar 
 

 

 
The status bar provides basic dashboard functionality. It dynamically reveals 
spatial details about the contents of the Map Canvas. From here, you can 
retrieve basic information such as map coordinates relative to a cursor 
position, the coordinate system being utilised by the data in view and the 
present scale at which the data are rendered.  

 

Note: Spend about five to ten minutes doing the following:    

 Try adding and removing different toolbars and panels get comfortable with 

customizing your interface.  

 

 Try shifting around/repositioning the toolbars to change the appearance of 

your interface. To shift a toolbar around, simply left-click on the left end of 

the toolbar; hold and then drag it to a new location on the interface. 

 

 Try hovering your mouse over the toolbar icons to learn the names of the tools 

 

 Explore the different function menus on the interface 

Be sure to raise any questions you may have with the instructors.  
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3 BASIC DATA OPERATIONS IN QGIS 

The following sections utilize GIS data which was made available prior to the 
workshop in a zipped format. Before conducting the exercises, you must unzip 
the data directory to your desktop. The unzipped folder is named, 
“GIS_Workspace”. From this point onward, any mention of the term 
“workspace” should be regarded as a reference to this directory. Your 
workspace shall serve as a repository for all the data supplied for the workshop 
and any output generated from the exercises that follow. Be sure to save your 
QGIS project to the workspace under the name, “Practical Exercise 1A”. The 
save functions may be accessed from the [Project] menu in QGIS at any time. 
 

3.1 Adding Data to QGIS 

The first step to working with data in any GIS platform is to import it. Your 
workspace should contain a set of GIS files which you will be importing into 
QGIS using the methods illustrated.  
 

3.1.1 Using the Browser Panel to Add Data 

 

1. Activate the Browser Panel and navigate the filing system to locate your 
workspace folder on the Desktop. 

 

 

Note: You will see a list of files positioned in the hierarchy under your 

GIS_Workspace directory on the Desktop. The file you will be loading is called, 
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“Global_Countries_WGS84.shp”. It is a Vector data file that graphically represents 

the physical extent and configuration of space consumed by all countries in the world.  

 

2. Import “Global_Countries_WGS84.shp” into QGIS by double-clicking the 
file with the mouse.  
 
Note: A polygon, vector object showing all countries in the world should now be 

visible in the Map Canvas – see image below. Greater details on vector GIS data 

will be explored in latter exercises. 

 

3. Activate the Layers Panel 
 

Note: This reveals a list of all the layers presently imported to QGIS. So far you‟ve 

only added one data layer, so you should see only one entry – (see the following 

image) 
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4. Position your mouse over the data layer in the Layers Panel; right-click; 
select {Remove} from the menu that appears. Select {OK} from pop-up box 
that appears.  
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Note: These actions, remove data from QGIS. Once completed, the data layer 

previously added will neither be visible in the Layers Panel nor the Map Canvas. 

The next step examines a second method for importing data.  
 

5. Return to the Browser Panel and locate the same data layer previously 
added (“Global_Countries_WGS84.shp”). 
 

6. Using your mouse – highlight the layer by applying a single left-click. 
 

7. Hit the {Add} button at the top of the Browser Panel to import the data file 
to QGIS. 

 

 

Note: Once again, the data layer (“Global_Countries_WGS84.shp”) has been added 

to QGIS and is visible in the Layers Panel and the Map Canvas.  

In the next step you will experiment with importing more than one data layer at the 

same time. Remove the present layer before proceeding.  

8. From the Browser Panel – Locate and select/highlight the following layers 

 

 “Spain_Provinces_WGS84.shp” 

 “Spain_60LargestCitiesByPopulation_WGS84.shp” 
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Note:  To select/highlight more than one data layer from the Browser Panel, press 

and hold the Ctrl key on your keyboard while left-clicking each layer you wish to 

add. To deselect a layer previously highlighted, hold the Ctrl key and left-click the 

layer.  

 

9. Right-click any of the highlighted files and choose {Add Selected Layers} 
from the drop-menu. 
 

 

Note: This adds two new vector layers to the Layers Panel which are visible in the 

Map Canvas. “Spain_Provinces_WGS84.shp” is a polygon vector layer that illustrates 

the geographical extent and distribution of provinces across the country of Spain. 

“Spain_60LargestCitiesByPopulation_WGS84.shp” is a point vector layer that 

represents the approximate point locations of 60 cities in Spain, ranked by population 

size (Source: www.tageo.com). 

 

 

http://www.tageo.com/
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10. Activate the Layers Panel to see the list of layers present in QGIS. Your 
Layers Panel should now have two data layers and your Map Canvas 
should show an overlay of these layers with the city points plotted on top of 
the provinces of Spain. 

 

Tip: More than one layer may also be removed at the same time. You can do this by 

pressing and holding the Ctrl key and clicking on each layer in the Layers Panel to 

select them. Once selected, right-click on any highlighted layer in the list and select 

{Remove}. 

Tip: Vector layers may also be added from the [Layer] main menu. Navigate to 

[Layer]  {Add Layer}  {Add Vector Layer}; use the Browse system menu to locate 

and open the file; then hit the {Open} button to add the layer. The same layer may be 

imported to QGIS multiple times. Hence, try adding another copy of the provinces 

layer via this method – see next image. 
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3.2 Manipulating Map Objects in QGIS 

Now that you’ve successfully added and removed data from QGIS, you should 
get to know the basic map functions and the parts of the interface where they 
can be accessed. Follow the next set of instructions to get up to speed. 
 
Before proceeding, make sure that you have only one instance of the provinces 
and of the cities layers present in the Layers Panel. If you’ve removed layers 
from the previous steps or added extra copies of the provinces and cities layers 
to the map, then make the necessary imports to/removals from the Layers 
Panel. 
 

3.2.1 Enabling and Disabling Data Layers 

 

1. From the Layers Panel – click on the ‘x’ in the checkbox next to the cities 
layer (“Spain_60LargestCitiesByPopulation_WGS84.shp”) in the list. 
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Note: This disables the layer so that the vector points representing the cities can no 

longer be seen in the Map Canvas.  

 

2. Enable the points (cities) layer again by clicking inside the checkbox area. 

Note: Checking the box again makes the „x‟ and also the vector points in the Map 

Canvas reappear. 

 

3. Experiment with enabling and disabling the provinces layer. 

 

3.2.2 Shifting Layer Positions 

 

The ordering of layers in the Layers Panel sometimes impacts how data are 
graphically represented in the Map Canvas. For example, your current Map 
Canvas shows points (cities) that are drawn on top of the polygon shapes of 
provinces within Spain. These objects appear this way because in the Layers 
Panel, points (cities) are listed above the polygon (Spanish provinces). Next, 
you’ll try changing the order of objects in the Layers Panel and then observing 
the results in the Map Canvas. 
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1. Use your mouse to select/highlight and drag the polygon layer 
(“Spain_Provinces_WGS84”) to the top of the list. 

The action results in a change in the appearance of map objects. Before, the 
point (cities) symbols were positioned on top of the polygon features 
(Provinces). Now, the point symbols are hidden from view. 
 

 

Note: Placing the polygon shape at the top of the Layers Panel has instructed QGIS 

to draw the polygon (provinces layer) on top of the points (cities). This hides the cities 

from view because the solid polygon shape (which has a larger extent) overlaps the 

point objects. It must be stressed that the point features are still present in the Map 

Canvas but just blocked from view. For example, if you were to apply a degree of 

transparency to the polygon shape, the cities would be visible underneath.  

 

2. Return the polygon shape to its original position before proceeding. 

 

3.2.3  Pan, Zoom and Identify Map Functions 

 

When working with map layers, it is often necessary to manipulate objects by 
moving them around the Map Canvas and/or changing the extent of view by 
zooming in and out. You may also need to identify or obtain details about 
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specific map features. The next steps demonstrate how these actions may be 
performed.  
 

1. Select/Enable the Pan tool from the Toolbar list. 

 

 

2. Point your mouse over the objects in the Map Canvas. Now click and hold 
your mouse down, while moving it in any direction you choose (left, right, up, 
down, etc.). 

 

Note: This allows you to move the objects across the Map Canvas in the same direction as 

your mouse. Return the map objects to a central position before proceeding. Feel free to 

use the Pan tool (highlighted above) at any point during this exercise to centre the objects 

in the Map Canvas for better viewing. 

 

3. Select/Enable the Zoom In tool from the Toolbar list. 

 

 

4. Left-click, hold and drag your mouse over a small area surrounding the point 
features (cities) in the north; then release the mouse. 
 
 

Tip: Pick any area with points in the north; start at a position that is northwest of 

any cluster of cities; click, hold and drag to the east and then to the south. This 

will create an area (highlighted by a transparent square) around the cities. When 

you release the mouse, QGIS will zoom into this area 
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These actions provide a closer view of the northern section of the map. 
 
5. Click on the Zoom Last tool. 

 

 

 

Note: The Map Canvas should have returned to its original extent.  

 
 

6. Click on the Zoom Next tool to revisit the zoomed in view of the northern 
part of Spain 
 

 

 

Note: This returns your Map Canvas to the extent seen after step 4. 

 

7. Pick different areas to Zoom in to and then try toggling between the Zoom 
Last and Zoom Next tools. 
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Note: This switches the Map Canvas back and forth between the original extent 

and the zoomed in version. As you experiment with this, observe the activity in the 

Status Bar as the map scale changes. 
 

8. Return the Map Canvas to its zoomed-in extent of the north. 
 

9. Select/Enable the Zoom Out tool from the Toolbar. 
 

 

 

10. Place your mouse over the map and left-click repeatedly until the data is 
fully in view.  
 

 

 

Tip: If you have zoomed out too far, you may reverse your action by using the 

Zoom Last tool or the Zoom In tool. Remember to use the Pan tool to centre your 

map for better viewing if required. 
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11. Zooming may also be accomplished with a mouse wheel. If your mouse has 
a wheel then position the pointer over the objects in the Map Canvas; scroll 
up and down and see what happens. 

Note: Using the mouse wheel will zoom to or away from map objects. When 

experimenting with the mouse wheel and zooming, the Pan, Zoom Last and Zoom 

Next tools may be used to control the positioning and extent of map objects.  

 

12. Hit the Zoom Full tool button to return the map to its original and full extent.  

 

 

 

Note: This tool (Zoom Full) changes the view so that the entire map is fully 

visible, centred and zoomed to its full extent.  

 

Now that you‟ve learnt about the pan and zoom map functions, you will learn 

about a very important tool known as the Identify tool. 

 

13. Disable the cities layer. 

 

14. Select/Highlight the polygon layer (“Spain_Provinces_WGS84”) in the 
Layers Panel and then select/enable the Identify tool from the Toolbar list. 

 

 

 

 

15. Position your mouse over any of the provinces in the layer and left-click. 
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A new window should appear on your interface like that which is shown below. 

 

This is the Identify Results table. 

Once activated, it will most likely 

be docked underneath the 

section with the Browser and 

Layers panels. To get a better 

view of this tool, it is best to 

undock it and resize the window.  

Do the following: 

 

 

 

 

 

 

16. Undock the Identify Results table by double clicking in the area highlighted 
in the image below. 
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17. If necessary, resize the window so that all of its contents are visible.  
 
 
 
 
 
 
 

Double –click here 
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Note: The Identify Results table 

provides details on the feature you 

clicked on with the Identify Tool. 

Under the Feature column, the 

table currently lists names of 3 

fields of information (i.e. 

COUNTRY, PROVINCE and 

TYPE.). The “COUNTRY” field 

lists the name of the country of 

each province. The “PROVINCE” 

field lists the names of the 

provinces and the “Type” field 

indicates the category of 

administrative division within the 

country. These fields are known 

as data attributes and the 

corresponding data shown in the 

Value column may be used to aid 

analysis. The illustrated example 

shows attribute data for the 

Province of Zamora.  

 

Information in the Identify Results table may also be viewed in another way. 

Locate and click the “View Feature Form” icon at the top of the Identify Results 

table.  

 

 

 

 

This will launch a 

separate table that 

presents the data 

attributes in a more 

user-friendly 

manner, via the use 

of a form. Refer to 

the image on the 

right. 
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18. After reviewing the data attributes of the Provinces layer, close the form 
window. 
 

19.  Return the Identify Results table to its original dock location by double 
clicking in the same area used to undock it.  

 

Tip: You can set the Identify Tool to automatically open a feature form when 

used. Do this by selecting the Auto open form option as shown below. If this 

option is selected, the next time the tool is used, a form will automatically pop up 

displaying attribute information for the feature you have clicked on.   

 

 
Close the Identify Results 

table to remove it from the 

interface.  

 
 
20. Practise using the 
Identify Tool to obtain 
attribute information for 
other provinces in Spain 
and also for various points 
in the cities layer. 
 

Tip: For use of the Identify 

Tool with cities, recall that 

this layer was previously 

disabled. You will therefore 

need to first re-enable it 

before proceeding. You are 

also reminded that the 

Identify Tool only works on 

layers that have been 

highlighted in the Layers Panel. Finally, you are advised to zoom in before 

attempting to click on city points with the Identify Tool. This is because it is 

sometimes harder to accurately select points with the Tool at larger map scales.  

 

Tip: You may use the Zoom Full tool to return all map objects to the full extent of 

view after zooming in. 
 

21. Close the Identify Results table and all associated forms that were opened 
and return all map layers to the full extent.  
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4 THE DATA PROPERTIES MENU 

There are ten categories of data properties that may be explored for any data 
layer loaded in the Layers Panel.  Many of these properties may be changed in 
different ways to enhance visualization of data or support more effective 
analysis. In other instances, these properties may be accessed simply to obtain 
information about the dataset. In this section, the data properties menu for the 
cities layer will be explored. Some of the categories under the properties menu 
will be illustrated and briefly explained.  
 
1. Right-click on the cities layer in the Layers Panel and select {Properties} 

from the menu. 
 
Note: The {Properties} menu should appear as shown below.  

 
 

 

 

Tip: The {Properties} menu may also be accessed by first highlighting a layer in 

the Layers Panel and then browsing to {Properties} within the main [Layer] 

menu. 
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As seen in the previous image, the ten data property categories are listed 
vertically on the left of the menu. These are as follows: 
 
 General 
 Style 
 Labels 
 Fields 
 Rendering 
 Display 
 Actions 
 Joins 
 Diagrams 
 Metadata 
 

Clicking on any of the categories on the left opens up menu options on the 
right which may be accessed to obtain information about the data layer or to 
change the layer’s characteristics for the purposes of visualization and/or 
analysis. Four of these category tabs which will be accessed in further 
workshop exercises are briefly explained below. 

 

4.1 The General Properties-Tab 

 

 



 
 

30 

 1
st
MedCOF Training Workshop.  Madrid, 26-30 October 2015 

 

Sections of the General properties-menu are described below: 
 

 Layer Info – This section of the menu may be accessed to: 
 

o Change the layer name as it is displayed in the Layers Panel 
 

o See the file path to the data layer as stored on the system - This is 
particularly useful when dealing with multiple datasets stored in 
different locations. Knowing where your data is located is very 
important when conducting geoprocesses. 

 

 Coordinate Reference System – This section provides information about 
the Coordinate System the layer is registered in. Understanding the 
coordinate systems applied to all datasets in the Layers Panel is important. 
The type of coordinate system associated with a data layer can have 
implications for processes that may need to be carried out on the layer. Also, 
because of the need for compatibility between layers used in analysis or for 
mapping purposes, it is always important to know what coordinate system 
your layer uses. 
 

 Scale Dependent Visibility – This part of the menu is used to control the 
range of scales for which features in your data layer are visible. For 
example, at larger scales, it may be difficult to absorb high levels of detail in 
some features. Therefore, this setting may be used to render these complex 
features invisible until one zooms to a smaller map scale where the features 
can be better assimilated.  

 
 Feature Subset – Features within a data layer may be hidden from view by 

entering an expression into this field with the Query Builder. Some 
exposure to query building will be provided in further exercises.   
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4.2 The Style Properties-Tab 

 

 

 

This menu is used to change the way layers are rendered in QGIS. Changes 
made here will impact the way a layer appears in the Map Canvas. Examples 
of changes that can be made are as follows: 

 Colours used to render vector and raster files may be changed using a 
wide array of options. 
 

 Symbols used to represent vectors can be changed, also using a wide 
variety of options 
 

 The presentation of data layers may be changed to reflect categorization 
using attribute information for visualization and analytical purposes. 
 

 Other visualization characteristics can also be applied. For example, 
layers can be made transparent to a specified degree.  
 

More in-depth exploration of the Style properties will be conducted in Practical 
Exercise 1B. 
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4.3 The Labels Properties-Tab 

 

 

 

Labelling of features in layers is often a requirement for mapping and visual 
analysis. The ability to use a layer’s attribute information for labelling is provided 
by this menu. There are also a set of controls within this menu that help to place 
labels appropriately on a map so that they can be properly seen and/or so that 
they do not obstruct the view of other important information being portrayed. 
Use of this menu will be demonstrated in Practical Exercise 1B. 
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4.4 The Metadata Properties-Tab 

 

Metadata is often an overlooked part of data management in GIS. However, if 
metadata has been assigned to layers you are working on, it can be accessed 
here. You may also use this tab to add metadata to your layers as follows: 

 The Description section – You can use this section to add information 
which describes the dataset. For example under the Abstract field, you 
may choose to write a brief summary of what the data illustrates, when it 
was prepared, the purpose of its creation and any other relevant piece of 
information about the data which other users may find useful.  
 

 The Attribution section – Use this section to provide a link to an external 
site which informs users of the source of the data or those who may be 
responsible for its creation.  
 

 MetadataUrl section – Sometimes metadata is available via an external 
online source in html or text-based format. If such a metadata source 
exists for the layer in question. You may add the address for it here.  
 

 LegendUrl– Add a link to an external legend here 
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 The Properties section provides basic information about most vector 
and raster layers. Examples of information obtained in this section of the 
menu include: 
 
o The file format (ESRI Shapefile, Geotiff etc.) 

 
o The file source  (i.e. the location of file on the system) 

 
o The nature of the file (e.g. whether a vector polygon, point or line or a 

raster etc.) 
 

o Geographical extent of the layer (i.e. the bounding coordinates) 
 

o The spatial reference system applied to the layer 
 

 

This concludes Practical Exercise 1A. Hopefully you now have an appreciation 
for some of the key features of the interface and are ready to explore Practical 
Exercise 1B which addresses some of the basic workflow operations involving 
vector and raster data in QGIS.  


